
การพฒันาเว็บเพจดว้ยโปรแกรมส าเร็จรปู

3204-2202

ภาคเรียนที่  1/2558



จุดประสงค ์รายวิชา  เพือ่ให ้

1. มีความรู้ความเขา้ใจเก่ียวกบัความส าคญัของการพฒันาเวบ็เพจ
2. สามารถพฒันาเวบ็เพจดว้ยโปรแกรมส าเร็จรูป
3. เห็นคุณค่าความส าคญัของการพฒันาเวบ็เพจ
มาตรฐานรายวิชา
1. สามารถออกแบบเวบ็เพจ
2. สามารถเลือกใชซ้อฟตแ์วร์ท่ีเหมาะสมในการพฒันาเวบ็เพจ
3. สามารถสร้างและเขียนโปรแกรมท าเวบ็เพจ



ค าอธิบายรายวิชา

ศึกษาและปฏิบติัเก่ียวกับการใช้โปรแกรมส าเร็จรูปเพ่ือ
การพฒันาเวบ็เพจ ปฏิบติัการพฒันาเวบ็เพจดว้ยโปรแกรม
ส าเร็จรูป เช่น Forntpage Express. Microsoft ForntPage” 
Dreamweaver. Namo Esitor Flash หรือโปรแกรมอ่ืนๆ ท่ี
เหมาะสมโดยครอบคลุมการจัดข้อความ รูปภาพ  การ
เช่ือมโยง  การสร้างตาราง  สร้างเฟรม การใช ้Layout การ
ใช ้Layer การก าหนด Behavior การผสม Multimedia การ
สร้างฟอร์ม  การท าภาพเคล่ือนไหวบนเวบ็ไซต์



ประเภทของเว็บไซต์

เว็บไซต์วารไรตี้  เป็นเว็บไซต์ลักษณะน้ีจะรวบรวมทุอย่างไว้เกือบ
ทั้ งหมด  มีทั้ งสาระ เช่น ข่าวคราวความเคล่ือนไหวในสังคม  ความ
บนัเทิง เช่น ข่าวดารา ดูดวง  เล่นเกมส์  หรือแมแ้ต่การแลกเปล่ียนความ
คิด เ ห็นกันในเว็บบอร์ด   ซ่ึ ง เว็บไซต์ลักษณะน้ี ท่ี เรา รู้จักได้แ ก่  
www.pantip.com หรือ www.sanook.com

เว็บไซต์ข่าวสาร  เวบ็ไซตป์ระเภทน้ีจะน าเสนอข่าวท่ีเกิดข้ึนในแต่ละวนั  
ส่วนใหญ่จะเป็นเว็บไซต์ท่ีท ามาเพื่อ Support หนังสือพิมพ ์สถานีวิทย ุ 
หรือโทรทศัน์  ซ่ึงจะสรุปหัวขอ้ข่าวท่ีน่าสนใจ  หรือรับชมรายการข่าว
ยอ้นหลงัแบบวิดีโอกไ็ด้

http://www.pantip.com/
http://www.sanook.com/


เวบ็ไซต์วารไรตี ้WWW.PANTIP.COM  

http://www.pantip.com/
http://www.pantip.com/
http://www.pantip.com/
http://www.pantip.com/
http://www.pantip.com/


เวบ็ไซต์วารไรตี ้WWW.SANOOK.COM  

http://www.sanook.com/
http://www.sanook.com/
http://www.sanook.com/
http://www.sanook.com/
http://www.sanook.com/


ประเภทของเว็บไซต์

เว็บไซต์รวบรวมข้อมูลน่าสนใจ   เว็บไซต์ลักษณะน้ี
เปรียบเสมือนคลงัขอ้มูลให้กบัผูท่ี้มีความสนใจเขา้มาเก็บ
เก่ียวความรู้  เพ่ือน าไปพฒันาอาชีพ  หรือเร่ืองท่ีตนเอง
สนใจ รวมถึงเว็บท่ีให้ข้อมูลด้านการท่องเทียว  ท่ีพัก
โรงแรม และการเดินทาง
เว็บไซต์ขององค์กรธุรกิจ    เวบ็ไซตล์กัษณะน้ีจะถูกสร้าง
ข้ึนเพ่ือสนบัสนุนองคก์รเพ่ือประชาสัมพนัธ์  หรือสร้างข้ึน
เพ่ือเป็นช่องทางในการประกอบธุรกรรม  ซ่ึงอาจจะมีเร่ือง
ของ E-commerce เขา้มาเก่ียวขอ้งดว้ย



E-COMMERCE
E-commerce ย่อมาจาก Electronic Commerce หรอืแปลเป็น

ไทยว่า พาณิชย์อิเล็กทรอนิกส์ คือ การท าธุรกรรมหรือประกอบ
ธุรกิจที่เกี่ยวกับการซื้อขายสินค้า หรือบริการผ่านเทคโนโลยี
คอมพิวเตอร์ หรือสื่ออิเล็กทรอนิกส์

เว็บไซต์ E-commerce คือ เว็บไซต์ที่จ าหน่ายสินค้า หรือบริการ
ผ่านทางระบบอินเตอร์เน็ต โดยตรงถึงผู้เข้าชมเว็บไซต์



ประเภทของเว็บไซต์

 เว็บไซต์การศึกษา  เว็บไซต์การศึกษาส่วนใหญ่เป็นเว็บของโรงเรียน 
มหาวิทยาลยั  โดยมีจุดประสงค์เพ่ือเป็นศูนย์กลางกระจายข่าวสารของ
สถาบนัไปยงันักเรียน  นักศึกษา  รวมถึงการเผยแพร่ความรู้ทั้ง  เน้ือหาท่ี
สอนในรูปแบบต่างๆ  เช่น  E-learning,  E-book  รวมถึงข่าวคราวท่ี
เสริมสร้างความรู้ความเขา้ใจดา้นอ่ืนๆ  ดว้ย

 เว็บไซต์ด้านความบันเทิง เวบ็ไซต์ลกัษณะน้ีมกัไดรั้บความนิยมจากกลุ่ม
วยัรุ่นเป็นอย่างมาก  ซ่ึงส่วนใหญ่จะน าเสนอเร่ืองราวเก่ียวกับดารา  วง
ดนตรี  ภาพยนตร์  กีฬาหรือเทรนด์ต่างๆ  ท่ีอยู่ในกระแส  โดยเว็บไซต์
ลักษณะน้ีจะมีจุดเด่นท่ีมีลูกเล่นบนเว็บ  ไม่ว่าจะเป็นเสียงเพลง  วิดีโอ  
ภาพเคล่ือนไหว  หรือภาพ Background  สีสันสดใส เพ่ือดึงดูดนกัท่องเวบ็ท่ี
เป็นกลุ่มวยัรุ่น



ประเภทของเว็บไซต์

เว็บไซต์ส่วนตัว  ส่วนน้ีจะมีจุดประสงคใ์นการสร้างท่ีแตกต่างกนั  แต่
ส่วนใหญ่เรามกัพบเห็นจะเป็นเวบ็ไซตใ์นลกัษณะแนะน าตวัเอง  หรือ
ผลงานต่างๆ  ท่ีเราเรียกว่า Portfolio  รวมถึงเวบ็รุ่นท่ีจดัท าประวติัเพื่อน
ฝงูใหส้ามารถติดต่อกนัได ้ หรือเวบ็ของครอบครัว  เป็นตน้

เว็บไซต์ให้บริการฝากไฟล์  เว็บลกัษณะน้ีก าลงัไดรั้บความนิยมอย่าง
แพร่หลาย  เน่ืองจากสร้างความสะดวกสบายให้กบันกัท่องเวบ็มากข้ึน  
เพราะสามารถฝากไฟล์งานขนาดใหญ่ให้ดาวน์โหลดได ้ รวมถึงการ
ดาวน์โหลดเพลง  หรือโปรแกรมมาใชง้านไดเ้ช่นกนั



ประเภทของเว็บไซต์

เว็บไซต์สังคมออนไลน์  เวบ็ไซต์สังคมออนไลน์  หรือ Social 
Network  ถื อว่าเป็นแหล่งชุมนุมนกัท่องเวบ็ทุกรูปแบบท่ีมี
ความชอบในทิศทางเดียวกนัไวด้ว้ยกนั โดยทุกคนจะมีโอกาส
ในการร่วมแชร์ประการณ์  โดยการโพสตค์วามคิดเห็นโตต้อบ
กนั  นอกจากน้ียงัสามารถแชร์ภาพถ่าย  หรือวิดีโอให้ทุกคนได้
เห็น  จนหลายคนแจง้เกิดเป็นนกัร้องนกัแสดงระดบัอินเตอร์เลย
ท่ีเดียว  และน้ีเป็นสาเหตุท าให้เว็บไซต์สังคมออนไลน์ได้รับ
ความนิยมมากข้ึน  ทุกขณะ



DOMAIN NAME

Domain Name คือชื่อที่ใช้แทนที่อยู่ หรือเลข IP Address ของ
เว็บไซต์ของคุณ ซ่ึงถูกต้ังขึ้นเพื่อให้คนทัว่ไปสามารถเข้าถึงเว็บไซต์
ของคุณได้ง่ายขึ้นโดยไม่ต้องเพิมพ ์IP Address ที่จ ายาก ก็สามารถ
เข้าเว็บไซต์ของคุณได้

ตัวอย่างเช่น เว็บไซต์ Google.com มี IP Address เป็น 
74.125.225.17

Domain Name: Google.com
IP Address: 74.125.225.17
คือแทนที่เราจะพิมพ์ 74.125.225.17 เราก็พิมพ์แค่ Google.com 
ก็เขา้เว็บ Google ได้แล้ว



การพิมพ ์IP Address: 74.125.225.17  จะปรากฏหน้า Google 



IP Address คือหมาย เลขประจ าเครื่องคอมพิวเตอร์ ซึ่ง
ประกอบด้วยตัวเลข4 ชุด มีเครื่องหมายจุดขั้นระหว่างชุด เช่น
192.168.100.1 หรือ172.16.10.1 เป็นต้น        

ก าหนดให้IP address (เป็นหมายเลข3 หลัก4 กลุ่ม) มี
ทั้งหมด 32 bit หรือ4 byte แต่ล่ะbyte จะถูกคั่นด้วยจุด (.) 
ระบบหมายเลขประจ าเครื่องมีข้อบกพร่อง คือ จ ายากและไม่ได้สื่อ
ความหมายให้ผู้ใช้งานทั่วไปได้ทราบ ดังนั้น จึงมีการใช้ระบบชื่อ
ของเครื่อง (Domain Name System : DNS) ซึ่งจะเป็นการ
เปลี่ยนหมายเลขIP Address มาเป็นชื่อที่คนทั่วๆ ไปเข้าใจ
กัน  เช่น  Moe.go.th / udru.ac.th / microsoft.com



โดเมนเนม (DOMAIN NAME)
 โดเมนเนม ความหมายโดยทั่วๆ ไป หมายถึง ชื่อเว็บไซต์ ชื่อบล็อก ซึง่เป็นชื่อที่ตั้งขึ้นเพื่อให้

จดจ าและน าไปใช้งานได้ง่าย ทั้งในการเข้าชมผ่านบราวเซอร์ของผู้ใช้ทั่วไป ยังรวมไปถึงผู้ดูแลระบบ
โดเมนเนมซีสเทม ที่สามารถแก้ไขไอพีแอดเดรสของชื่อโดเมนเนมนั้นๆ ได้ทันที
โดยที่ผู้ใช้ทั่วไปไม่จ าเป็นต้องรับรู้หรือจดจ าไอพีแอดเดรสที่มีการเปลี่ยนแปลง 
เครื่องคอมพิวเตอร์ที่ท าหน้าที่เผยแพร่เว็บไซต์ จะมีโดนเมนเนมเฉพาะไม่ซ้ ากับใคร
โดนเมนเนม มีด็อทอยู่หลายประเภทแต่ที่นิยมมากที่สุดนั้นก็คือ .com เพราะเป็นด็อทในยุคแรกๆ ที่เริ่ม
ใช้กัน และง่ายต่อการจดจ า
ประเภทของ Domain Name แบ่งไดเ้ป็น 2 ประเภท 
  1.  โดเมน 2 ระดับ   ชื่อโดเมน . ประเภทของโดเมน
  2.  โดเมน 3 ระดับ   ชื่อโดเมน . ประเภทของโดเมน . ประเทศ

 โดนเมนเนม 2 ระดบั 
จะประกอบด้วย  www . ชื่อโดเมน . ประเภทของโดเมน เช่น www.b2ccreation.com
ประเภทของโดเมน คือ ค าย่อขององค์กร โดยประเภทขององค์กรที่พบบ่อย มดีังต่อไปนี้
    * .com คือ บรษิัท หรือ องค์กรพาณิชย์        * .org คือ องค์กรเอกชนที่ไม่แสวงผลก าไร
   * .edu คือ สถาบันการศึกษา                   * .gov คือ องค์กรของรัฐบาล        

    * .net คือ องค์กรที่เป็นเกตเวย์ หรือ จุดเชื่อมต่อเครือข่ายงทหาร   * .mil คอื องค์กรทา 



โดนเมนเนม 3 ระดับ  


จะประกอบด้วย www . ชื่อโดเมน . ประเภทของโดเมน . 
ประเทศ เช่น www.kmitnb.ac.th, www.nectec.or.th, 
www.google.co.th
ประเภทขององค์กรที่พบบ่อยคอื 
    * .co คือ บริษัท หรือ องค์กรพาณิชย์
    * .ac คือ สถาบันการศึกษา
    * .go คือ องค์กรของรัฐบาล
    * .net คือ องค์กรที่ให้บริการเครือข่าย
    * .or คือ องค์กรเอกชนที่ไม่แสวงผลก าไร
ตัวย่อของประเทศที่ตั้งขององคก์ร 
    * .th คือ ประเทศไทย
    * .cn คือ ประเทศจีน
    * .uk คือ ประเทศอังกฤษ
    * .jp คือ ประเทศญี่ปุ่น
    * .au คือ ประเทศออสเตรเลีย

http://www.google.co.th/


ประโยชน์ของ Domain Name ที่ดี
จ าง่ายกว่า IP Address ท าให้คนท่ัวไปสามารถเข้าเว็บถึง
เว็บไซต์ได้ง่ายขึ้น
ถ้า Domain Name ดี จะช่วยให้ติดอันดับในผลการค้น ของ 
Search Engine ต่างๆ ได้ดีขึ้นท าให้เว็บไซต์ดูน่าเชื่อถือมากขึ้น



วิธีเลือก Domain Name
• Domain Name ควรจะสั้น และจ าง่าย คือไม่ควรเกิน                    
4 พยางค์
•  ควรเป็นชื่อที่จ าง่าย จะมีความหมายหรือไม่มีก็ได้
•  ควรเป็นชื่อที่สื่อความหมายถึงเว็บไซต์ของเรา เช่น ถ้าเป็น
เว็บไซต์ บริษัท ก็ควรเป็นชื่อบริษัท ถ้าเป็นเว็บไซต์ ร้านอาหาร 
ก็ควรเป็นชื่อร้านอาหาร หรือถ้าเป็นเว็บให้ความรู้เกี่ยวกับ
สุขภาพ ก็ควรมีค าที่เกี่ยวกับสุขภาพอยู่ในชื่อด้วย เช่นค าว่า 
Health



(ต่อ) Domain Name ไม่สามารถซ้ ากับ Domain Name อื่นที่มีอยู่ 
แ ล ะ เ ร า ก็ ไ ม่ ค ว ร ตั้ ง ใ ห้ ค ล้ า ย ค ลึ ง กั บ ข อ ง ที่ มี อ ยู่  เ ช่ น 
Roomsexchange.com มีคนอื่นจดไปแล้ว เราก็ไม่ควรตั้ง 
Roomexchange.com เพราะจะท าให้สับสนได้ง่าย เป็นต้น  
ปัจจุบัน ชื่อ Domain Name สามารถเป็นภาษาไทยได้ ในกรณีที่
เว็บไซต์คุณจะมุ่ งเน้นเฉพาะผู้ เข้าชมที่ เป็นคนไทย การจดชื่อ 
Domain Name ภาษาไทยเลยก็จะเข้าถึงกลุ่มคนไทยได้ง่ายขึ้น
นามสกุล .com, .net, .org หรืออื่นๆ ก็มีความส าคัญ ช่วยบ่งบอกว่า
เว็บไซต์ของคุณเป็นเว็บไซต์ประเภทอะไร เช่น .org ย่อมาจาก 
Organization ส่วนมากจะใช้กับเว็บที่ไม่แสวงหาก าไร .ac.th จะบ่ง
บอกว่าเป็นเว็บไซต์การศึกษา เป็นต้น ซึ่งราคานามสกุลก็จะแตกต่าง
กันออกไป



เครือข่ายใยแมงมุม (WORLD WIDE WEB)

เครือข่ายใยแมงมุม (World wide web หรือ W3 หรือ WWW)   
เวิลด์ไวด์เว็บเรียกสั้น ๆ ว่า เว็บ (Web) เป็นรูปแบบหนึ่งของ

ระบบ  (WWW), การให้บริการข้อมูลแบบไฮเปอร์เท็กซ์
   การเชื่อมโยงเครือข่ายข่าวสาร ใช้ในการค้นหาข้อมูลข่าวสาร      

บนอินเทอร์เน็ต มีการเชื่อมโยงข้อมูลจากแหล่งข้อมูลหนึ่งไปยังอีก
แหล่งข้อมูลที่อยู่ห่างไกล เพื่อให้มีความง่ายต่อการใช้งานมากที่สุด

http://dict.longdo.com/search/World Wide Web (WWW)


เว็บเซิร์ฟเวอร ์(WEB SERVER) ความหมาย คือ
เป็นคอมพิวเตอร์ที่เก็บเว็บเพจ เมื่อใดที่เราต้องการเปิดดูเว็บเพจ 

เราต้องใช้บราวเซอร์ดึงข้อมูล โดยที่บราวเซอร์จะท าการติดต่อ
กับเว็บเซิร์ฟเวอร์นั้น เพื่อให้มีการโอนย้ายข้อมูลมาแสดงที่เครื่อง
ของเรา

เครื่องคอมพิวเตอร์ซึ่งให้บริการที่เก็บเว็บไซต์ (Server) แล้วให้
ผู้ใช้ (Client) เรียกชมหน้าเว็บไซต์ได้โดยใช้โพรโทคอล HTTP 
ผ่านทางเว็บเบราว์เซอร์



การใช้งาน WEB SERVER

• เมื่อผู้ใช้ป้อนยูอาร์แอล (URL) ในโปรแกรมเว็บ
เบราว์เซอร์ เช่น IE, Firefox, Google chome

• เครื่องไคลแอนท์จะแปลงชื่อโฮสต์ ภายในยูอาร์แอล
เป็นไอพีแอดเดรส

• เครื่องไคลแอนท์ติดต่อกับเครื่องเวบ็เซิร์ฟเวอร์ โดย
ปกติจะใช้โพรโทคอล TCP พอร์ต 80

• เมื่อท าการเชื่อมต่อเสร็จ จะใช้โพรโทคอล HTTP ใน
การเรียกใช้ข้อมูลที่ต้องการ



เว็บบราวเซอร์ และเว็บเซิร์ฟเวอร์
Web server หัวใจส าคัญของทุกเว็บไซต์ที่จะต้องมี ส าหรับเทคโนโลยี

บนโลกไอทีที่ต้องออนไลน์ เว็บไซต์เป็นสิ่งจ าเป็นในหลายหน่วยงาน หรือ
องค์กร เราสามารถถ่ายทอดข่าวสารผ่านเว็บไซต์ ไม่ว่าจะเป็นข้อมูลต่างๆ 
ความรู้ ความบันเทิง ประกาศ และการประชาสัมพันธ์ เบื้องหลังของ
เว็บ ไซต์ต่ า งๆ  เหล่ านี้ ต้ อ งท า งานอยู่ บน เว็บ เซิฟ เวอร์  เพื่ อจะ
รัน Script ให้เราได้ดูและเข้าใจในสิ่งที่เว็บไซต์นั้นๆ สื่อให้เราเห็น ถ้าไม่
มี Web Server แล้วสิ่งที่เห็นบนเว็บไซต์นั้นจะเป็นแค่โค๊ตทาง
ภาษาคอมพิวเตอร์ ไม่สามารถรู้ได้ว่าเป็นอะไร และไม่น่าสนใจด้วย ซึ่ง 
โค๊ต หรือ script เหล่านี้เมื่อท างานอยู่เป็น web server แล้วเปิดใช้งาน
ผ่าน browser จะรู้ได้ว่าเป็นอะไร



สรุปเพื่อจ า

*  Web server คือ เครื่องผู้ให้เก็บข้อมุลเว็บโดยใช้ 
HTHTTPTP(HyperText Transfer Protocol) ส่งสง
ผลเป็น html ให้ web Browser เพื่อให้ผู้ใช้สามารถเข้า
มาดูข้อมูล ภาพ เสียง ผ่าน web browser

*  Web Browser คือ โปรแกรมที่ท าหน้าที่แสดงเนื้อหา
เว็บไซต์ โดยแปลง เป็น html script เป็นข้อความที่เรา 
สามารถดูได้ เว็บบราวเซอร์ที่ได้รับความนิยม ได้แก่ 
Internet Explorer, Netscape, Mozilla Firefox 
Google Chome

http://www.mindphp.com/%E0%B8%84%E0%B8%B9%E0%B9%88%E0%B8%A1%E0%B8%B7%E0%B8%AD/73-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3/2046-http-https-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3.html
http://www.mindphp.com/%E0%B8%9A%E0%B8%97%E0%B8%84%E0%B8%A7%E0%B8%B2%E0%B8%A1/66-server-hosting/1849-web-browser-%E0%B8%AB%E0%B8%A1%E0%B8%B2%E0%B8%A2%E0%B8%96%E0%B8%B6%E0%B8%87%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3-web-browser-%E0%B8%84%E0%B8%B7%E0%B8%AD.html


เริม่ตน้สรา้งเว็บไซต์

หน้าแรกของเวบ็ไซต์เรียกว่า  Home Page  จะใชแ้รกหนา้
แรกของเว็บไซต์ท่ีเราเปิดเข้ามาเจอ หรือท่ีภาษาไทย
เรียกว่าหน้าหลกั   นักออกแบบเว็บจะต้องออกแบบให้
สวยและลงตวัท่ีสุด  เพราะวา่จะเป็นตวัก าหนดอารมณ์ของ
เวบ็ไซต ์ ท่ีส าคญัผูเ้ขา้ชมเวบ็ไซตจ์ะเปิดดูเน้ือหาน้ีดว้ย  ถา้
เปรียบเทียบง่ายๆ  เหมือนกบัปกหนังสือท่ีตอ้งออกแบบ
ให้ดูดี  และสะดุดตาท่ีสุด  รวมถึงต้องแสดงเน้ือหาให้
ครอบคลุมมากท่ีสุด แต่ตอ้งไม่รกและดูซบัซอ้นเกินไป 



อินเทอร์เน็ต (INTERNET) 
หมายถึง เครือข่ายคอมพิวเตอร์ขนาดใหญ่ ที่มีการ

เชื่อมต่อระหว่างเครือข่ายหลาย ๆ เครือข่ายทั่วโลก โดย
ใช้ภาษาที่ใช้สื่อสารกันระหว่างคอมพิวเตอร์ที่เรียกว่า 
โพรโทคอล (protocol) ผู้ใช้เครือข่ายนี้สามารถสื่อสาร
ถึงกันได้ในหลาย ๆ ทาง อาทิ อีเมล เว็บบอร์ด และ
สามารถสืบค้นข้อมูลและข่าวสารต่าง ๆ รวมทั้งคัดลอก
แฟ้มข้อมูลและโปรแกรมมาใช้ได้

http://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%84%E0%B8%A3%E0%B8%B7%E0%B8%AD%E0%B8%82%E0%B9%88%E0%B8%B2%E0%B8%A2%E0%B8%84%E0%B8%AD%E0%B8%A1%E0%B8%9E%E0%B8%B4%E0%B8%A7%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C
http://th.wikipedia.org/wiki/%E0%B8%AD%E0%B8%B5%E0%B9%80%E0%B8%A1%E0%B8%A5
http://th.wikipedia.org/wiki/%E0%B8%AD%E0%B8%B5%E0%B9%80%E0%B8%A1%E0%B8%A5
http://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B8%9A%E0%B8%AD%E0%B8%A3%E0%B9%8C%E0%B8%94
http://th.wikipedia.org/wiki/%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1


ไคลเอนต์/เซิร์ฟเวอร์ (CLIENT/SERVER NETWORK)
ไคลเอนต์/เซิรฟ์เวอร์ (client/server) คือ การที่มีเครื่องผู้ให้บริการ 

(server) และเครื่องผู้ใช้บริการ (client)
เชื่อมต่อกันอยู่ และเครื่องผู้ใช้บริการได้มีการติดต่อร้องขอบริการจาก

เครื่องผู้ให้บรกิาร เครื่องผู้ให้บริการก็จะจดัการ
ตามที่เครื่องผู้ขอใช้บริการร้องขอ แล้วส่งข้อมูลกลบัไปให้เครือข่ายแบบ 

ไคลเอนต/์เซิรฟ์เวอร์ เหมาะกับระบบเครือข่าย
ที่ต้องการเชื่อมต่อกับเครื่องลูกข่ายจ านวนมาก โดยการรองรับจ านวน

เครื่องลูกข่าย (Client) อาจเป็นหลักสิบหลักร้อย 
หรือหลักพนั เพราะฉะนั้นเครื่องที่จะน ามาท าหนา้ที่ให้บริการจะต้องเป็น

เครื่องที่มี ประสิทธิภาพสงู เนื่องจากถูกต้องออกแบบ
มาเพื่อทนทานต่อความผิดพลาด ( Fault Tolerance)และต้องคอย

ให้บริการทรพัยากร  การใหก้ับเครื่องลูกขา่ยตลอดเวลา
โดยเครื่องที่จะน ามาท าเป็นเซิรฟ์เวอร์อาจเป็นคอมพิวเตอร์แบบ

เมนเฟรม มินิคอมพิวเตอร์ หรือไมโครคอมพิวเตอร์ก็ได้



เครือขา่ยประเภทนี้จะมีเครื่องศูนย์บริการ ที่เรียกว่า เครือ่งเซิรฟ์เวอรแ์ละมี
เครื่องลูกข่ายต่าง ๆ เชื่อมต่อ โดยเครือข่าย  หนึ่งอาจมีเครื่องเซิรฟ์เวอร์
มากกว่าหนึ่งตัวเชื่อมต่อภายในวงแลนเดียวกัน ซึ่งเซิรฟ์เวอร์แต่ละตัวก็ท า
หน้าที่รับผิดชอบที่แตกต่างกัน เชน่
1.ไฟล์เซริฟ์เวอร์ (File Server) คือ เครื่องที่ให้บริการแฟ้มข้อมูลให้แก่เครื่อง

ลูกขา่ย
2.พรินตเ์ซิรฟ์เวอร์ (Print Server) คือ เครื่องที่บริการงานพิมพ์ให้แก่เครื่อง
ลูกข่าย โดยบันทึกงานพิมพเ์ก็บไว้ในรูปแบบของสพลู (Spool) และ
ด าเนินการพิมพ์งานตามล าดับคิว

3.ดาต้าเบสเซิร์ฟเวอร์ (Database Server) คือ เครื่องทีบ่ริการฐานข้อมูล
ให้แก่เครื่องลกูข่าย

4.เว็บเซริฟ์เวอร์ (Web Server) คือ เครื่องที่จัดเก็บข้อมูลด้านเว็บเพจของ
องค์กร เพื่อให้ผู้   ท่องอินเตอร์เน็ตสามารถเข้าถงึเว็บขององค์กรได้

 5.เมลเซิร์ฟเวอร์ (Maill Server) คือ เครือ่งที่จัดเก็บข้อมูลด้านจดหมาย
อิเล็กทรอนิกส์ หรือ E-mail ที่มีการรับสง่ระหว่างกันภายในเครือข่าย



เว็บบราวเซอร์ และเว็บเซิร์ฟเวอร์
   เว็บเบราเซอร์ (web browser) เบราเซอร์ หรือ โปรแกรมค้น

ดูเว็บ คือโปรแกรมคอมพิวเตอร์ ที่ผู้ใช้สามารถดูข้อมูลและ
โต้ตอบกับข้อมูลสารสนเทศที่จัดเก็บในหน้าเวบที่สร้างด้วย
ภาษาเฉพาะ เช่น ภาษาเอชทีเอ็มแอล ที่จัดเก็บไว้ที่ระบบ
บริการเว็บหรือเว็บเซิร์ฟเวอร์หรือระบบคลังข้อมูลอื่น ๆ โดย
โปรแกรมค้นดูเว็บเปรียบเสมือนเครื่องมือในการติดต่อกับ
เครือข่ายคอมพิวเตอร์ขนาดใหญ่ที่เรียกว่าเวิลด์ไวด์เว็บ
 เว็บเบราว์เซอร์ตัวแรกของโลกชื่อ เวิลด์ไวด์เว็บ ขณะเดียวกันเว็บ

เบราว์เซอร์ที่นิยมมากที่สุดในปัจจุบันคือ อินเทอร์เน็ตเอกพลอเรอร์



เว็บไซต์ ( WEBSITE, WEB SITE หรือ SITE)

เว็บไซต์ ( Website, Web site หรือ Site) หมายถึง หน้าเว็บเพจหลาย
หน้า ซึ่งเชื่อมโยงกันผ่านทางไฮเปอร์ลิงก์ ส่วนใหญ่จัดท าขึ้นเพื่อน าเสนอ
ข้อมูลผ่านคอมพิวเตอร์ โดยถูกจัดเก็บไว้ในเวิลด์ไวด์เว็บ  หน้าแรกของ
เว็บไซต์ที่เก็บไว้ที่ชื่อหลักจะเรียกว่า โฮมเพจ เว็บไซต์โดยทั่วไปจะให้บริการ
ต่อผู้ใช้ฟรี แต่ในขณะเดียวกันบางเว็บไซต์จ าเป็นต้องมีการสมัครสมาชิก
และเสียค่าบริการเพื่อที่จะดูข้อมูล ในเว็บไซต์นั้น ซึ่งได้แก่ข้อมูลทาง
วิชาการ ข้อมูลตลาดหลักทรัพย์ หรือข้อมูลสื่อต่างๆ ผู้ท าเว็บไซต์มี
หลากหลายระดับ ตั้งแต่สร้างเว็บไซต์ส่วนตัว จนถึงระดับเว็บไซต์ส าหรับ
ธุรกิจหรือองค์กรต่างๆ การเรียกดูเว็บไซต์โดยทั่วไปนิยมเรียกดูผ่าน
ซอฟต์แวร์ในลักษณะของ เว็บเบราว์เซอร์



ช่ือของเวบ็ไซต์เรียกว่า DOMAIN NAME

Domain Name เป็นค าท่ีเรียกช่ือของเวบ็ไซต ์เช่น 
www.infopress.co.th,  www.texhxcite.com เป็นตน้ 
ซ่ึง   น้ีจะต้องก าหนดก่อนท่ีจะเร่ิมต้นออกแบบ
เวบ็ไซต ์ เน่ืองจากอาจถูกน าไปใชแ้ลว้ก็ได ้ท่ีส าคญั
ควรสอดคล้องกับข้อมูลในเว็บด้วย  โดยการ
ตรวจสอบและขอช่ือ Domain Name

http://www.infopress.co.th/
http://www.texhxcite.com/


DOMAIN NAME

Domain Name (โดเมน) คือ ชื่อเว็บไซต์ (www.yourdomain.com) 
ที่ท่านสามารถเป็นเจ้าของ ซึ่งจะต้องไม่ซ้ ากับคนอื่น เพื่อการเรียกหา
เว็บไซต์ที่ต้องการ "ชื่อเว็บไซต์" คือ สิ่งแรกที่แสดง หรือ ประกาศความมี
ตัวตนบนอินเตอร์เน็ตให้คนทั่วไปได้รู้จัก สามารถมีได้ชื่อเดียวในโลก
เท่านั้น เช่น www.gict.co.th เมื่อผู้ใช้กรอกชื่อลงไปในช่อง Address 
ของ Internet Explorer ก็จะส่งชื่อไปร้องถามจากเครื่องแปลชื่อ โดเมน 
(Domain Name Server) และได้รับกลับมาเป็นไอพีแอดเดรส 
(Internet Protocol) แล้วส่งค าร้องไปให้กับเครื่องปลายทางตามไอพี
แอดเดรส และได้ข้อมูลกลับมาตามรูปแบบที่ร้องขอไป
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กขระที่จะใช้ในการตั้งชื่อโดเมน

 ช่ือ Domain สามารถใช้ ตัวอักษรภาษาไทย ภาษาอังกฤษ ตัวเลข และ "-" 
(ยัติภังค์) ได้

ชื่อ Domain โดยปกติ จะขึ้นต้นด้วยตัวอักษร และลงทา้ยด้วยตัวอักษรหรือ
ตัวเลข

ชื่อ Domain มีความยาวตั้งแต่ 1 ถึง 63 ตัวอักษร

ชื่อ Domain ตัวอักษรตัวใหญ่ A-Z หรือตัวอักษรตัวเล็ก ถือว่าเหมือนกัน

ชื่อ Domain ต้องไม่ขึ้นต้นหรือลงทา้ยด้วยเครื่องหมาย - และต้องไม่มี Space
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หลักการตั้งชื่อโดเมน ภาษาไทย
ชื่อ Domain จะต้องไม่เกี่ยวข้องกับพระมหากษัตริย์ พระราชวงศ์ พระ

บรมวงศานุวงศ์ และสถานที่ที่เก่ียวข้องกับพระมหากษัตรยิ์ พระราชวงศ์ 
และพระบรมวงศานุวงศ์

ชื่อ Domain จะต้องไม่ก่อให้เกิดความเสื่อมเสียชื่อเสียงแก่ผู้หนึ่งผู้ใด หรือ
องค์กรหนึ่งองค์กรใด

ชื่อ Domain จะต้องไม่เป็นชื่อต่าง ๆ ของประเทศไทย จังหวัด รวมถึง
สถานที่อันเป็นสาธารณะต่าง ๆ ในประเทศ

ชื่อ Domain จะต้องไม่ประกอบด้วยค าหยาบหรือค าที่ผิดต่อศีลธรรมอันดี
งามของไทย

ชื่อ Domain จะต้องมีความสัมพันธ์อย่างหนึ่งอย่างใดกับชื่อโดเมน
ภาษาอังกฤษที่อ้างอิงดังนี้
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การจดทะเบียนโดเมนเนม
 โดเมน นามสกุล .OR.TH ใช้ท าเวบ็ไซต์ของส่วนราชการ และชื่อโดเมนต้องเป็นชื่อของ

องกร หรือตัวย่อของชื่อองค์กรนั้นๆ ต้องใช้ส าเนาเอกสารทางราชการเป็นหลักฐาน
การจดทะเบียน

 โดเมน นามสกุล .AC.TH เป็นเวบไซตืของสถานศุกษาต่างๆ ชื่อของโดเมนที่จด
ทะเบียนต้องเป็นชื่อของสถานศึกษานั้นๆ หรือชื่อย่อของชื่อสถานศึกษา ใช้ส าเนา
เอกสารการขออนุญาตก่อตั้งสถานศึกษาเป็นหลักฐาน

 โดเมน นามสกุล .IN.TH เป็นเวบไซต์ของบุคคลธรรมดาโดยทั่วไป ชื่อโดเมนจะใช้ชื่อ
อะไรก็ได้ ใช้ส าเนาบัตรประชาชน หรือส าเนาใบขับขี่เป็นหลักฐานการจดทะเบียน

 โดเมน นามสกุล .GO.TH เป็นเวบไซต์ของส่วนราชการของประเทศไทย โดยปกติจะ
เป็นองค์กรขนาดใหญ่

 โดเมน นามสกุล NET.TH เป็นเว็บไซต์เกี่ยวกับบริษัททีเ่กียวกับระบบ Network หรือ 
ISP (ผู้ให้บริการอินเตอร์เน็ต) ในประเทศไท
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การจดทะเบียนโดเมนเนมต่างประเทศ
การจดทะเบียนโดเมนเนมต่างประเทศจะได้นามสกุล โดเมน 

เป็น .COM .NET .ORG
 โดเมน นามสกุล .COM ใช้ท าเว็บไซต์ของบริษัท ห้างรา้นโดยทั่วไป 

รวมทั้งเว็บไซต์ส่วนตัว และมีบางครัง้น าไปใช้ท าเว็บไซต์ (web 
site) ประเภทอื่นๆ ด้วย

 โดเมน นามสกุล .NET ใช้ท าเว็บไซตเ์กี่ยวกับระบบเน็ตเวิร์ค 
(network) ของคอมพิวเตอร์ หรือเว็บไซต์บริการอินเตอร์เน็ต แต่
บางครั้งก็น าไปใช้ด้านอืน่ด้วย

 โดเมน นามสกุล .ORG ใช้ท าเว็บไซต์ของส่วนราชการ บางครั้งก็มี
การจดทะเบียนน าไปใช้กบัเว็บไซต์ประเภทอื่นด้วย
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 ปัจจุบันได้เกิด โดเมน ชนิดอื่นขึ้นอีกมากมาย เนื่องจากว่ามีการพยายามแบ่ง
ประเภทเว็บไซต์ออกไป และขณะเดียวกันชื่อ โดเมน ก็เหลือน้อยลง ดังมี
รายละเอียดดังนี้
 โดเมน นามสกุล .cc เป็น โดเมน ที่คาดว่าน่าจะมีความนิยมทัดเทียมกับ .com ในเวลา

อันใกล้นี้เนื่องจาก .com แทบจะไม่มีชื่อดีๆ เหลืออยู่แล้ว การน าไปใช้งานสามารถ
น าไปใช้กับเว็บไซต์ธุรกิจโดยทั่วไปได้

 โดเมน นามสกุล .biz ส าหรับเว็บไซต์ธุรกิจโดยทั่วไป เป็น โดเมน น้องใหม่ พึงเกิดขึ้นจาก
การรวมกลุ่มธุรกิจที่เปน็ ธรุกิจจริงๆ ซึ่งก็ได้รับความสนใจและเป็นทีรู่้จักคอ่นข้างเร็ว

 โดเมน นามสกุล .info ใ
 ส าหรับเว็บไซต์ที่ให้รายละเอียดเกียวกับข้อมูลต่างๆ เช่น ข้อมูลของประเทศต่างๆ เปน็ต้น
 โดเมน นามสกุล .ws เป็นชนิดของชื่อเว็บไซต์หนึ่งที่พยามยามสร้างขึ้นมาเพื่อแข่งขันกับ 

.cc การน าไปใช้งานสามารถน าไปใช้ได้กับทุประเภทเวบ็ไซต์
 โดเมน นามสกุล .tv เป็นเว็บไซต์ของสื่อโฆษณาต่างๆ โดยเฉพาะสื่อทางด้านภาพและ

เสียง ปัจจุบนัค่อนข้างได้รับความนิยมจากเว็บไซต์ประเภทสื่อพอสมควร
 แม้ว่าปัจจุบันจะมีโดเมนถูกน าเสนอออกมาหลายประเภท หลายชนิดก็ตาม แต่ 

.com .net และ .org ก็ยังถือว่าเป็นโดเมนมาตราฐานสากล ที่ได้รับความนิยม
และยอมรับกันอย่างกว้างขวางทั่วโลก
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ส่วนประกอบหน้าจอ DREAMWEAVER
1. แถบชื่อเรื่อง (Title Bar) แสดงชื่อแฟ้มข้อมูลที่ก าลังใชง้านอยู่ 
2. แถบค าสั่ง (Menu Bar) เป็นส่วนที่เก็บค าสั่งต่าง ๆ ท่ีใช้งานในโปรแกรม         
   Dreamweaver CS3
3. แถบเครื่องมือ (Document Tool Bar) เปน็ส่วนที่ใช้ในการจัดการกับเว็บเพจ ณ 
    ขณะนั้น เช่นการเปลี่ยนมุมมองในการดูหน้าเว็บเพจ 
4. แถบแทรก (Insert Bar) เป็นกลุ่มเครื่องมือท่ีใช้สร้างองค์ประกอบต่าง ๆ 
     ในเว็บเพจซึ่งประกอบด้วยชุดเครื่องมือ 8 ชุดด้วยกัน 
5. พื้นที่ออกแบบ (Document Window) เป็นส่วนที่ใช้ส าหรับใส่เนื้อหาและจัด 
     องค์ประกอบของเว็บเพจ โดยประกอบด้วยมุมมองการท างาน 3 รูปแบบด้วยกันคือ 
   Design, Code และ Code and Design
6. แถบสถานะ (Status Bar) เป็นส่วนที่แสดงสถานะของการใช้งานโปรแกรม ณ 
     ขณะนั้น หน้าต่าง Properties เป็นส่วนของค าสั่งที่ใช้ในการก าหนดคุณสมบัติของ
     องค์ประกอบต่าง ๆ ที่เราต้องการเปลี่ยนแปลงหรือตกแต่ง 
7. กลุ่มพาแนล (Panel Group) เป็นกลุ่มของแผงควบคุมที่ใช้แทนค าสั่งและติดต่อ
     กับฐานข้อมูล
8. Property Inspector แสดงค่าการปรับองคป์ระกอบต่างๆ บนหน้าเว็บไซต์



หน้าทีใ่ช้แสดงข้อมูลทั้งหมดคอื WEB PAGE

Web  page เปรียบเสมือนหนา้กระดาษของหนงัสือเล่มหน่ึง ท่ีมีทั้ง
ภาพและขอ้ความในการแสดงขอ้มูลท่ีน่าสนใจ  ส าหรับการออกแบบ
หนา้ Web page  ท่ีดีจะตอ้งมีความเป็นเอกภาพ คือ คงรูปลกัษณ์เดิม
ของหนา้ Home  page  และสามารถเปิดสลบัไปมาระหว่างหนา้  
รวมถึงกลบัสู่หนา้ Home page ไดอ้ยา่งง่ายดายดว้ย    ทุกหนา้รวมกนั
เรียกว่า Web page ส าหรับค าว่า Web site เป็นค าท่ีเราทุกคนคุน้เคย
มากท่ีสุด ซ่ึงจะใชเ้รียกหนา้ Home page และหนา้ Web page ทั้งหมด
รวมกัน เปรียบได้กับหนัง สือ  1  เ ล่ม  ท่ีต้องมีทั้ งหน้าปกและ
หนา้กระดาษดา้นในนัน่เอง



เว็บเพจหนึง่หนา้ควรมีอะไรบา้ง

A  แสดงตัวตนบน Page Header หรือส่วนหัวของเว็บเพจ  จะเป็น
พื้นที่ Free Style ที่สามารถออกแบบภาพกราฟิกหรือ
Animation สวยๆ  ลงไปเพื่อสร้างความประทับใจ แต่จะต้องมี
ความสอดคล้องกับเนื้อหาของเว็บไซต์ด้วย

B  เนื้อหาน่าสนใจจะใส่ไว้ใน Page Body คือ ส่วนที่ใช้แสดง
เนื้อหาของเว็บไซต์ มักวางไว้ตรงกลางหน้า  ซึ่งเป็นได้ทั้ง
ข้อความ รูปภาพ และวีดีโอ แต่หน้าHome Page อาจจะใส่
เฉพาะหัวข้อเท่านั้น  สิ่งส าคัญของ Page  Body  คือ จะต้องจัด
วางเลย์เอาต์ให้เป็นระเบียบและน่าสนใจ



เว็บเพจหนึง่หนา้ควรมีอะไรบา้ง

C แสดงรายละเอียดผู้จัดท าที่ Page Footer  เป็นส่วนล่างสุดของ
เว็บไซต์  ซึ่งจะมีหรือไม่ก็ได้  โดยส่วนใหญ่จะใส่ข้อความลิขสิทธิ์ 
และค าแนะน าการใช้เว็บไซต์  หรือลิงค์เชื่อมโยงไปยังเว็บไซต์อื่น

D  เชื่อมโยงด้วยลิงค์  เป็นส่วนที่ใช้เชื่อมโยงไปยัง Web Page หน้า
อื่นๆ หรือกลับมาสู่หน้า  Home Page รวมถึงการเชื่อมโยงไปยัง
เว็บนอกด้วย โดยลิงค์ที่วางเป็นแนวนอนใต้ Page Header เรา
จะเรียกว่า Navigation Bar แต่ถ้าวางเป็นแนวตั้งไว้ด้านซ้ายหรือ
ขวา จะเรียกว่า Sub Link



เตรียมพร้อมกอ่นสร้างเว็บไซต์ของตนเอง
1. เลือกกลุ่มเป้าหมาย การเลือกกลุ่มเป้าหมายนี้ควรท าเป็น

อันดับแรก  เนื่องจากกลุ่มเป้าหมายจะเป็นตัวก าหนดว่า
เนื้อหาในเว็บจะเป็นอย่างไร  รวมทั้งการออกแบบเว็บเพจด้วย

2. รวบรวมข้อมูลของเว็บ คือ การจัดเตรียมเนื้อหาที่ต้องการ
น าเสนอว่ามีอะไรบ้าง โดยให้แบ่งหมวดหมู่ของเนื้อหาตาม
ความเหมาะสม

3. เตรียมภาพประกอบ  ควรจัดหาภาพประกอบทั้งที่ใช้ในการ
ออกแบบตกแต่งเว็บ รวมถึงภาพที่เป็น Content ในเว็บด้วย 
โดยให้เตรียมไว้มากๆ  เผื่อไว้ส าหรับออกแบบ



เตรียมพร้อมก่อนสร้างเว็บไซต์ของตนเอง (ต่อ)

4. วางโครงร่างหน้าเว็บเพจ  เป็นขั้นตอนการก าหนด่าหน้าเว็บเพจ
แต่ละหน้านั้นวางอะไรไว้ตรงไหนบ้าง  เช่น จะวางโลโก้ของเว็บไว้
จุดไหน  ข้อมูลของเว็บอยู่ส่วนใด เป็นต้น

5. ก าหนด Theme การก าหนด Theme คือ การเลือกโทนสีให้เว็บ
ว่าจะมีลักษณะสีเป็นอย่างไร  ซึ่งการเลือก Theme นี้จะต้อง
สอดคล้องกับลักษณะกลุ่มเป้าหมายที่เลือกไว้ด้วย

6. ออกแบบการเชื่อมโยง  ขั้นตอนนี้จะต้องมีความพิถีพิถันพอสมควร 
เนื่องจากจะเป็นตัวก าหนดว่าเว็บของเราจะใช้งานง่ายหรืออยาก
แค่ไหน ซึ่งการท างานขั้นตอนนี้จะช่วยให้เรารู้ได้ว่าเว็บจะมีหน้า
หลักกี่หน้า ท าให้รู้ได้ว่าจะต้องสร้างปุ่มลิงค์กี่ปุ่มด้วย



สิ่งที่ต้องรู้เกี่ยวกับกราฟิกส าหรับเว็บ

ไฟล์ภาพยอดนิยมส าหรับงานเว็บ มี 3 แบบ ได้แก่ GIF,  
JPEG, PNG

1. GIF (Graphics Interchange Format)  เป็นไฟล์ภาพที่มีขนาด
เล็ก เนื่องจากจะลด ทอนสีให้แสดงได้สูงสุดที่ 256 สีเท่านั้น ดังนั้น 
ภาพที่น ามาใช้ควรมีรายละเอียดสีไม่มาก เช่น โลโก้  หรือ ภาพการ์ตูน
ที่เน้นลวดลายเส้นมากกว่าการไล่โทนสีที่ส าคัญไฟล์ภาพประเภทนี้ยัง
สามารถแสดงภาพแบบพื้นหลังทะลุ  (Transparency)  และใช้
บันทึกภาพเคลื่อนไหวได้ด้วย



สิ่งที่ต้องรู้เกี่ยวกับกราฟิกส าหรับเว็บ
  ไฟล์ภาพยอดนิยมส าหรับงานเว็บ มี 3 แบบ ได้แก่ GIF,  JPEG, PNG

2.  JPG, FPEG (Joint Photographic Export Group)  JPEG 1 เป็น
ไฟล์ภาพมาตรฐาน ส่วนใหญ่ได้จากการถ่ายภาพด้วยกล้องดิจิตอล ข้อดี
ของภาพ JPG คือ สามารถแสดงสีได้สูงถึง 16.7 ล้านสี ภาพจึงดูสมจริง 
ซึ่งสามมารถน าไปใช้ร่วมกับการออกแบบได้อย่างดี แต่อาจต้องเลือกใช้
บางจุดของเว็บเพจ เพื่อไม่ให้เว้บโหลดนานเกินไป อย่างไรก็ตาม เรา
สามารถลดขนาดไฟล์ภาพให้เล็กล่งได้ โดยการบีบอัดด้วย Photoshop  
ซึ่งจะช่วยให้ได้ไฟล์ภาพสวยๆ  ที่มีขนาดไม่หนักจนเกินไปด้วย



สิ่งที่ต้องรู้เกี่ยวกับกราฟิกส าหรับเว็บ

3.  PNG (Portable Network Graphics) เป็นไฟล์ภาพที่รวม
เอาคุณสมบัติของไฟล์แบบ GIF และ JPEG เข้าด้วยกันคือ 
สามารถบีบอัดไฟล์ภาพ ให้เล็กลงได้มากกว่า GIF ถึง 30% แต่ก็
คงแสดงสีได้มากถึง 16.7  ล้านสีด้วยนอกจากนี้ยังสามารถ
บันทึกไฟล์แบบพื้นหลังทะลุ  (Transparency) ได้ด้วย



ภาพละเอียด ไม่ละเอียดดูอย่างไร (RESOLUTION)

รูปภาพสวยๆ ที่เราเห็นอยู่บนจอคอมพิวเตอร์ เกิดจาก
การเรียงตัวของจุดสีที่เป็นสี่เหลี่ยมเล็กๆ (Pixel) โดย
จุดสีเหล่านี้จะมีระดับสีที่ไล่โทนแตกต่างกันไป เมื่อเรา
มองในภาพรวมก็จะเห็นเป็นภาพสวยๆ นั่นเอง ซึ่งจุด   
สีเล็กๆ หรือ Pixel ที่พูดถึงนี้ จะเป็นตัวก าหนความ
ละเอียด (Resolution) ของภาพด้วย



RESOLUTION ความละเอียด
 ส าหรับ Resolution หมายถึง จ านวนจุดสีที่เรียงต่อกันใน
หน่วยความยาวภาพ ยิ่งแน่นเท่าไร ภาพก็จะมีความละเอียด
สูงขึ้นเท่านั้น เช่น ถ้าภาพมี Resolution อยู่ที่ 72 
Pixels/Inches ก็หมายความว่าภาพนั้นมีจุดสีอยู่ 72 จุดในหนึ่ง
ตารางนิ้ ว  ความละ เอี ยดอยู่ ใ น ระดั บปกติ  แต่ ภ าพที่ มี 
Resolution 300 Pixels/Inches คือ ภาพที่มีจุดสีอัดแน่นถึง 
300 จุดในหนึ่งตารางนิ้ว ถือว่าเป็นภาพคุณภาพเยี่ยมเหมาะกับ
งานพิมพ์คุณภาพสูง



RESOLUTION ความละเอียด
ถึงแม้ภาพที่มีความละเอียดสูง จะให้ผลลัพธ์ที่ดีเยี่ยม แต่
การออกแบบกราฟิกบนเว็บไซต์ ความรวดเร็วในการแสดงผล
มีความจ าเป็นมาก ดังนั้น การก าหนดความละเอียดของภาพ
ที่สูงเกินไปย่อมเกิดผลเสียมากกว่าผลดี โดย Resolution ที่
เหมาะสมกับงานด้านนี้คือ 72  Pixels/Inches  เพราะ               
เป็นความละเอียดกับการแสดงบนจอคอมพิวเตอร์ซึ่งก็
เพียงพอแล้ว



รู้จักกับค่าความละเอียดของภาพ  (RESOLUTION)

Resolution คือ ค่าความละเอียดของภาพ ๆ หนึ่งซี่งก าหนด
เป็นจ านวนเม็ดสี (pixels) ต่หนึ่งหน่อยความยาวของภาพ ตัว
เช่น หากภาพนั้นมีค่า Resolution = 150 pixels/inches 
แสดงว่าในพื้นที่ 1 ตารางนิ้วของภาพนั้นประกอบไปด้วยเม็ด
สีจ านวน 150 สี (Pixels) เป็นต้น



RESOLUTION คอื ค่าความละเอยีดของภาพๆ

ภาพท่ีมีความละเอียด Resolution ต ่า
    (มีจ านวนเมด็สีนอ้ย)

ภาพท่ีมีความละเอียด Resolution สูง 
(มีจ านวนเมด็สีมากกวา่ในขณะท่ีมีพ้ืนท่ีเท่ากนั)



ท าไมเราต้องก าหนดค่า RESOLUTION

ในการท างานนั้นจะต้องอ้างอิงถึงค่า   อยู่เสมอเพื่อให้เกิดความเหมาะสม
กับการใช้งานประเภทต่าง ๆ นอกจากนั้นยังเกี่ยวข้องกับขนาดไฟล์งานอีก
ด้วย เพราะงานที่มีค่า   Resolution สูงก็จะมีขนาดของไฟล์ใหญ่ขึ้น
ตามไปด้วย ซึ่งอาจท าให้เกิดปัญหาในการท างาน เช่น ท าให้เครื่อง
คอมพิวเตอร์ของคุณประมวณผลช้าลงในกรณีที่สเปคเครื่องไม่สูงนัก ซึ่ง
หน่วยของ  Resolutionที่ใช้กันอยู่   2 แบบคือ     
 pixels/inch - จ านวนหรือปริมาณของเม็ดสี   ในพื้นที่ 1 ตารางนิ้ว     

 pixels/cm - จ านวนหรือปริมาณของเม็ดสี   ในพื้นที่ 1 ตารางเซนติเมตร

ค่า Resolution ที่เรานิยมใช้คือ  จ านวนพเิซลต่อนิ้ว หรือ  pixels/inch ( ppi )



ก าหนดค่า   RESOLUTION อย่างไรดี


       ในการใช้งานทั่วๆ ไปเรามักก าหนดความละเอียดของงานหรือค่า 
Resolution อยู่ที่ 100-1150 ppi (pixels/inch) แต่ส าหรับการท างาน
เกี่วกับเว็บไซค์นั้นเราจ าเป็นต้องใช้งานที่มีความละเอียดน้อยเพื่อให้มี
การแสดงผลที่รวดเร็ว จึงมักใช้ค่า Resolution = 72 ppi

ส าหรับการออกแบบสิ่งพิมพ์เรามักจะก าหนหดค่า Resolution 
อยู่ที่ 300-350 ppi เพราะต้องการความคมชัดในการแสดงผลสูง เช่น                     
งานออกแบบสิ่งพิมพ์ งานนิตรสาร โปสเตอร์ขนาดใหญ่ และสมุดภาพ
เป็นต้น
การตั้งค่าของ Resolution ให้ไปที่   Image - Image size



นอกจากภาพทีม่ีค่า RESOLUTION สูงจะใช้ความคมชัดกว่าแล้ว 
ขนาดไฟล์งานกจ็ะใหญ่กว่าด้วย

ภาพขนาด  1024x768 Resolution = 300 ppi
ขนาดไฟล ์2.87M เม่ือขยาย 200 เท่า

ภาพขนาด  1024x768 Resolution = 72 ppi
ขนาดไฟล ์169 k เม่ือขยาย 200 เท่า



ก าหนดค่า   RESOLUTION อย่างไรดี

       ในการใช้งานทั่ วๆ ไปเรามักก าหนดความละเอียดของงานหรือค่า 
Resolution อยู่ที่ 100-1150 ppi (pixels/inch) แต่ส าหรับการท างาน
เกี่ยวกับเว็บไซค์นั้นเราจ าเป็นต้องใช้งานที่มีความละเอียดน้อยเพื่อให้มีการ
แสดงผลที่รวดเร็ว จึงมักใช้ค่า Resolution = 72 ppi

ส าหรับการออกแบบสิ่งพิมพ์เรามักจะก าหนหดค่า Resolution อยู่ที่ 
300-350 ppi เพราะต้องการความคมชัดในการแสดงผลสูง เช่น งานออกแบบ
สิ่งพิมพ์ งานนิตรสาร โปสเตอร์ขนาดใหญ่ และสมุดภาพเป็นต้น



การตั้งค่าของ RESOLUTION ให้ไปที่   IMAGE - IMAGE SIZE



การก าหนดขนาดของเว็บเพจ
1024 X 768 พิกเซล
1028 X 800 พิกเซล หรือ1080 X 1024 พิกเซล
1366X 768 พิกเซล





การสร้างหัวเรื่องหน้าเว็บเพจ
1. File > New  สร้างไฟล์ใหม่ขนาด  800 หรือ 1000  X 300หรือ 350 พิกเซล

2. คลิกเครื่องมือ กราเดียน  เติมสีลงบนเลเยอร ์Background

3. คลิกเครื่องมือ  วาดกรอบสี่เหลี่ยมมุมมนและวาดแถบเมนูด้านล่าง



การสร้างหัวเรื่องหน้าเว็บเพจ
1. File > New  สร้างไฟล์ใหม่ขนาด  800 หรือ 1000  X 300หรือ 350 พิกเซล

2. คลิกเครื่องมือ กราเดียน  เติมสีลงบนเลเยอร์ Background

3. คลิกเครื่องมือ  วาดกรอบสี่เหลี่ยมมุมมนและวาดแถบเมนูด้านล่าง



การสร้างหัวเรื่องหน้าเว็บเพจ
1. File > New  สร้างไฟล์ใหม่ขนาด  800 หรือ 1000  X 300หรือ 350 พิกเซล

2. คลิกเครื่องมือ กราเดียน  เติมสีลงบนเลเยอร ์Background

3. คลิกเครื่องมือ  วาดกรอบสี่เหลี่ยมมุมมนและวาดแถบเมนูด้านล่าง



ออกแบบแถบเมนูลิงค์
1. คลิกเมนู  File  >  New  800 X 100 พิกเซล

2. Copy  ให้ได้เมนูที่  2  Ctrl + J

3. File > Save for Web บันทึกเป็นไฟล์  .GIF เพื่อให้มีพ้ืนโปร่งใส
ด้วย



การออกแบบแถบเมนูแนวตั้ง
1. คลิกเมนู  File > New สร้างไฟล์ใหม่ขนาด 200 X 350  พิกเซล เลือกพื้นแบบโปร่งใส



สร้างปุ่มกดใส่ไฮเปอรล์ิงค์ หน้า 185



สอบครัง้ที ่ 3

 ลกัษณะของตารางบนเว็บเพจ

     ตาราง (Table) ประกอบดว้ยแถว (Row) และคอลมัน ์(Column) ใช ้

ส าหรบัแสดงขอ้มูลทีต่อ้งการจดัล าดบั  จดัเรยีงเน้ือหา  และจดัหมวดหมู่  เพ่ือความเป็นระบบ

ระเบียบ  สะดวกในการคน้หา  แกไ้ขและน าไปใชง้าน

 การน าเสนอขอ้มูลในรูปตารางประกอบเวบ็เพจมีประโยชนอ์ยา่งมากโดยเฉพาะถา้เป็น ขอ้มูล

ตวัเลข  สถิต ิ มูลคา่  และราคาสนิคา้  ซึง่ชว่ยใหผู้ช้มเขา้ถึงแหลง่ขอ้มูลไดอ้ยา่งรวดเร็วและ

ครบถว้น  ตลอดจนสามารถเปรยีบเทยีบขอ้มูลทีห่าไดอ้ยา่งรวดเร็ว



1. วิธีสรา้งตารางบนเว็บเพจ

 1. การสรา้งตารางบนเวบ็เพจ  มีข ัน้ตอน  ดงัน้ี

 1.  เปิดเอกสารที่ตอ้งการจะสรา้งตาราง

 2.  เลือกเมนู  Insert > Table

 3. หรอืเลือกเครื่องมือ    (Table) ทีก่ลุม่เครื่องมือ  Common หรอืกลุม่
เครือ่งมือ  Layout



หรอืใชแ้ป้นพิมพ ์ < CTRL > + < T > จะได ้

หนา้ตา่ง  TABLE ดงัรูป



เลอืกลกัษณะของตาราง ดงันี้

1.  rows จ านวนแถวของตาราง
2.  columns จ านวนหลักของตาราง
3.  Table width ความกว้างของตาราง จะใส่เป็น Pixel เพื่อก าหนดความกว้างให้คงที่ หรือ 

Percent(%) เพื่อก าหนดความกว้างตามขนาดหนา้จอ ก็ได้
4.  Border thickness ความหนาของเส้นขอบตาราง ถ้าเราไม่ต้องการให้มีเส้นขอบให้ใส่เป็น 0
5.  Cell padding ระยะห่างระหว่างขอบตาราง กับเนื้อหาภายในตาราง
6.  Cell spacing ระยะห่างระหว่างช่อง
7.  Header จัดหัวข้อของตาราง <th> ข้อความที่อยู่ในช่องที่เป็นหัวข้อจะเป็นตัวหนา จะมี 3 แบบ คือ 

        7.1 left ให้หลักที่อยูท่างซา้ยมือเป็นหัวข้อตาราง     
        7.2 top แถวบนสุดเปน็หัวข้อ 
        7.3 Both แถวบนสุด และหลักซ้ายสุดเป็นหัวข้อ

8.  Caption ใส่ชื่อตาราง
9.  Align caption จัดต าแหน่งของชื่อตาราง
 10. Summary บรรยายตาราง
 



2. ก าหนดคา่ตา่ง ๆ ตามทีต่อ้งการ  เชน่  สรา้งตารางแบบ 3 

แถว  5  คอลมัน ์ เม่ือคลิกปุ่ม  OK จะไดต้ารางลกัษณะน้ี


